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A SECTION 1
' R SRR General

MiniL.SS is a programming software for SP-series PL.Cs. With MiniLSS you
can design the program, transfer it to and from a PLC, monitor PLC statuses
and print your program documents.

1.1. Hardware Requirements

MiniLSS requires the following hardware:

+ [BM compatible personal computer (IBM AT, 386 or 486)

¢ Hard Disk

+  Minimum of 640 kbytes memory
) « 1.44 Mb diskette drive dx

The following is required to download the program to a PLC: o

+  Serial Port (RS-232C) i

s SP<->PC cable &

The fallowing is requred to print documents:
» Paraliel port ‘
+ HP Laserdet compatible laser printer or IBM Graphics compatible matrix

printer ' B
PLC types supported by MiniLS$ are SP10, SP16 and SP20. ?.3;;:
F
P-L'

]

i

1.2. Installation

. MiniL.SS is delivered in one 1.44 Mb diskette. To‘ install the software, follow ~ 1: -
the following steps: '

+ Put the MiniLS$S diskette to your diskette drive (A or B)
Ls
= Type: AUNSTALL (if your diskette drive is A:) e

The installation program screen opens as illustrated below:
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can design the program, transfer it to and from a PLC, monitor PLC statuses
and print your program documents.

1.1.  Hardware Requirements

Minil.S$S requires the following hardware:

MIniLSS is a programming software for SP-series PLCs. With MiniLSS you ;E
e
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+ [BM compatible personal computer (IBM AT, 386 or 486)

¢ Hard Disk :

»  Minimum of 640 kbytes memory =
+ 1.44 Mb diskette drive $

The foliowing is required to download the program to a PLC:
+ Serial Port (RS-232C)
+ SP<->PCcable

The following is requred to print documents:

* Parallel port :

+ HP LaserJet compatible laser printer or IBM Graphics compatible matrix
printer '

PLC types supported by Minil.SS are SP10, SP16 and SP20.

1.2. Installiation

MiniL.SS is delivered in one 1.44 Mb diskette. To install the software, follow :i -
the following steps: i

» Putthe Minil.S$ diskette to your diskette drive (A: or B:)
¢
» Type: A:INSTALL (If your diskette drive is A2) e

The installation program screen opens as illustrated below:
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from the C:\MINILSS directory, you f_shogid modify your PATH slalemeat in
the AUTOEXEC.BAT file. Consult your DOS manual for doing that,

4
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2.1.The Editor Screen

i’ SECTION2

2 SECTION 2
Getting Started

If you didn't modify your PATH statement, you must change to the MinilLSs
directory before starting the program.
Start the program by typing:

MINILSS §,

I you are using MiniLSS with monochrome display, you can select the
monochrome display attributes by starting Minil.SS with command line
parameter "MONQ" like:

MINILSS MONO

The MiniLSS outlook can be selected to a LSS-style outlook (calted LSS
Mode or LSS-look in this manual) or to its own outlook (calted MiniLSS
Mode).

MiniL8$ starts with loading run -ﬁm_é files. After file loading is completed, the

editor screen opens, as in the following picture:

Note!l If you have selected the LSS-Look option, the screen will appear
different.

(4]
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Al the top line of Ihe screen s the menu bar. Below this is the diagram area,
where you will pul your relay symbols and mstructions. Just below the
diagram area are three lines (inilialized with MINILSS text) which are
reserved for displaying information about contacts at the cursor posiion.
Below these lines is the command key guideline, which gives function key
declarations. The bottom line is the status line, which shows available
memory in the computer, the off-ling/on-line status, addressing mode and
selected PLC type.

The cursor is the white block in the top left comer of the diagram area. If the
cursor is visible, you are working in the diagram area; if nol, the focus is
either in the menu bar or in the instruction list {discussed later). To switch

between menu bar and the diagram area press {Esc) or hold the §AR ) key
down and press any of the highlighted character keys.

, Online help can be accessed with

2.2.The Editor Screen in LSS Mode

In LSS Mode, the editor screen appears as in the foliowing picture:
mm..wv AR ; B

gt

The topline contains the editor mode (WRITE/READ). Below it begins the
diagram space. Just below the diagram space is the edil line, where ladder
elements and their addresses are edited. The ling below the edit line is the
function key guide, and the bottom line is the status ling, which shows
available memory in the computer, the off-line/on-iine stalus, addressing
mode and selecled PLC type.

To go to menu press fCui Jf M) or fEnd)
Online heip can be accessed with fCuT 1 H |

2.3.Editing Ladder Diagrams

Relay ladder eiements are
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Normmally open contact
Nomally closed contact
Output coil

Negated output coil
Horizental short
Vertical short

- & L] [ ) L] -

2.4.Editing in MiniLSS Mode

The elements can be accessed from elemeni-menu or with shortcut keys.
Setect the element by positioning the cursor and then select the menu item or
use a command key. The element will appear at the cursor position. If the
element s other than a vedical or horizon{al shon, assign an address to the

element. Type in the address and press E@ You can also ieave the

address blank by just pressing and specify the address afterwards.

To enter or change address of an existing contact, position the cursor on the
contact and press <space>. To enter or change operands to an existing
function, counter or timer, position the cursor on the operand and press

i
b
4 .

Shortcut function keys for relay elements are shown on the function key
guideline. Additional keys can used as well. The keys and corresponding
elements are:

Element name Element Shortcut
. symbol key
Normally open contact — F2. =
Normally closed contact | — / T F3./
Horizontal short F4 -
Vertical short [ F5,0]
Output coil - —) F6,0
Negated output coil —@ F7

In addition to hasic efements there are timers, counters and functions. Their
representation and shortcut keys are:

Element name Element ‘Shortcut
. symbol Key
Timer F9
=1 Timaor no.
T

56l Yaluo

Counter F10
=1 Countet no,
CHNY
—1{ Seal Value

e

W
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Funclion Fs F

“Function namo |

Opacend 1
Cperand 2
Cpetand 3

The elemenis can be drawn in any order. Their addresses and operands can
be filied at any time; the comect synlax is required only when compiling. {n
the positioning of elements the following rules must be obeyed:

e If there is output, timer, counter or funciion in a line, nothing can be
inserted 1o the right of i{.

« |If there are contacts or shorts in a line, no outpuis, timers, counters or
functions can be inserted 1o the left of them.

+ Elementis cannot overlap,

The ladder diagram appears as follows:

Elements can be deleted with the key. Position the cursor on the
required contact and press fDel]. Function blocks, counters and timers are
deieled by positioning the cursor over top of them and pressing fDel .

Elements can also be deleied with the backspace key. Posilion the cursor (0

the right of the contact to be deleted and press f+-} . The etement is deleted
and the cursor moves one column 1o the fefi.

Vertical shorts cannot be deleted with the fDel ] key. Instead they are toggted.
1e. drawing another vertical shor will defele the existing one

Emply lines can be deleted by holding (he {{Q_@J key down and pressing fer
Empty lines can be inserted by pressing 1ns .

MRS
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To move elements in one circuit rightwards starling at cursor location hold the

fiCui) key down and press =)

To move elements leftwards hold the ficut} key down and press ,

Outputs, timer, counters and functions can be forced to appear fight-justified.
Select the Justified Outputs from Options menu. The justification affects only
the display; it do not change the actual positions of elements. The horizontal
line needed to connect the justified outputs is displayed as dashed line to
indicate that it does not consist of true horizontal line elements. When you
select the Justified Quiputs again, the original positions are restored.

2.5.Editing in LSS Mode

n LSS Mode the editor is either in WRITE-mode, READ-mode or in
DELETE-mode. Diagrams can be edited only in WRITE-mode. In READ-
mode the diagrams can be viewed and searched, but not altered. Set the

editor to WRITE-mode with key [F2], and to READ-mode with key {71 ).

DELETE-mode can be accessed with key (Shift + F1),

When switching to READ-mode, the diagrams must be syntactically correct,
since a compilation to PLC object code takes place. In READ-mode the
corresponding line numbers in the PLC are displayed.

The elements can be accessed with function keys. Position the cursor to a
place where the element should appear and use a command key to select the
element type. The element will appear in the edit line. Enter the address if
required. Use function keys to select the memory area (e.g. |.R). When the

element and its address is as desired hit and the element will be
piaced into the cursor's position.

To change address of an existing contact position the cursor on the contact,

its type and curmrent address will be displayed in the edit line. Change the

address and press . To enter or change operands to an existing
function, counter or timer, position the cursor on the required operand, type

the address into the edit line and press .

Shorteut function keys for relay elements are shown on the function key
guideline. The keys and comesponding elements are:

Element name Etement Function
symbol key
F4,F5
Shift+F 4,
Shift+F5
Horizontal short F8
Vertical short F6&

_{ A
[_
Oulput coit _IO F7
—J

Normatly open contact
Normally closed contact

Negated output coil Shift+F7

1

b2
1
4

L e HE
P
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In addition to basic elements there are ti'gwers, counters and functions. Their

representation and function keys are:

Element name

Etement Function
symbol key

Timer

Cii+F9

— Timer no.
TIN
Sat Valug

Counter

—1 Countex no.
CHT
1 Sel Valug

Ctri+F10

Function

~1 Function name

Operand 1
Operand 2
Operand 3

To set the PLC memory areas,

following keys are used:

Memory Area Function
key
LR *Ctri+F1
DR Cirl+F2
*DR Ctri+F3
# (Constant) Ctri+F4
T/C Ctri+F5
/G, Wark Area Ciri+F6

The elements can be drawn in any order: the correct syntax is required only
when compiling. In the positioning of elements the following rules must be

obeyed:

« |If there is output, timer, counter ar functicn in a line, nothing can be i

inserted to the right of if.

« |f there are contacts or shoris in a line, no outputs; timers, counters or

functions can be inserted to the lef of them.

« Elements cannot overlap.

Elements can be deleted with the backspace key. Position the cursor to the

right of the contact to be defeted and press . The efement is deleted and
the cursor moves one column to the lefi.

To delete verical shor press first 50 that the vertical short appears in

the edit line and then hit fe-).

Empty lines can be deleted by holding the key down and pressing Y.

Empty tines can be inserted by pressing {ins].

16
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Elements can aiso be deleted in DELETE-fiode. Set the DELETE-mode by
pressing {6 ) {F1) (Shitt + F1). In DELETE-mode, the element under the

cursor is deleted by pressing (5097, After the element is deleted the oursor
will move one column to the right.

To move elements in one circuit rightwards starting at cursor location hiold the

key down and press {=3].
To move elements leftwards hold the key down and press <.

Outputs, timer, counters and functions can be forced to appear right<justified.
Select the Justified Outputs from Sefup menu. The justification affects only
the display; it do not change the actual positions of elements. The horizontal
line needed to connect the justified outputs is displayed as dashed line to
indicate that it does not consist of true horizontal line elements. When you
select the Justified Outputs again, the original positions are restored.

2.6.Editing Instruction Lists

Notel Instruction list elements are not supported in LSS Model

Instruction list and ladder diagrams can be combined in the Diagram Editor.
You can e.g. design the pure combination logic portions with ladder diagrams
and function emphasized portions with instruction list. Of course, you may
design the entire program with either ladder diagrams or instruction lists.

An instruction list program is divided into one or more instruction fist blocks,
with one instruction list element as the smallest biock. Dividing the list into
smailer blocks will help you to structure your program, thus making it much
more readable. Although you are not reguired to divide the program, this
method is slrongly recommended. Diagram comments (discussed later)
cannot be inserted into middle of the instruction {ist unit; instead they must be
in between the list blocks (or list elements).

An instruction list element is inserted into the diagram space either by
selecting it from the menu or by holding the key down and pressing

Place the cursaor in the line where you want the instruction list to begin and
insert the instruction list element. The screen appears as foliows:

11

i




SECTION 2

The empty frame in the middle of (he screen is a placehoider for the
instruction list. The ladder edilor cursor will disappear and a normal {ex
cursor will appear. The instruction field of the first program line is highlighted.
The function key definitions will change; these changes will be seen on (he
command Key guideline.

The length of the instruction list element is not limited; the frame will grow
and shrnk with the inserlion or deletion of instructions. Instructions can be
entered with function keys, as displayed on the command key guideline, or
they may aiso be entered by typing their names. When {yping names, case is
not imporant.

Aimost every instruction will include bolh an instruction code field and an
instruction operand field. The instruction code must be entered first, since the
number of operands depends on the instruction used. Type in the instruction

Enter| . : . S
and press «'—“—‘er, or use the function keys. After the instruction code field is

filled in, the cursor moves to the next field, which in most cases is the
operand field (if the instruction does not include operands, the curser moves
to the next instruction’s instruction code field). Filt in the operand(s) and then
lype in the next instruction code. After several instructions, the screen wall
appear as follows:
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You can insert several instruction list elements. It is best to program every
logicat entity as one element, as this will help you fater when trying (o iocate
certain program units.

The instruction list is divided into thres columns: the leftmost column is the
instruction code column, the middle column is the operand/address column
and the rightmost column is the symbof column, In the previous picture there
are no symbols defined, so the rightmost column is emply. The instruction
lists in the foliowing picture include some addresses (hat have predefinad
symbols, so the third column is used:

You can move from the address/operand field (o the symbol hekd with §
(1ahy or by moving the cursor beyend the nght end of addrass field To move
from the symbol hetd back (o the address field, hold the shuft key down and

P fk

Ior move the curser beyond the tell end of symbol field Press the




oy
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4] and {{4] keys to move from one igstruclion to another. Al the end of
every instruction list element there is always an empty instruction. When the
cursor is there and an instruction is typed, this instruction is automatically
inserted at the end of the list and an empty instruction added to the end of the
list element.

To insert a new instruction into the middle of the list, move the cursor (and
the highlight) to the iine where you want the new instruction to be placed and

then press {ins}. To delete an entire instruction hold the key down and
press V).
When you mave upwards from the top instruction or downwards from the last

instruction, the ladder cursor appears and the command guideline changes,
indicating that you are back in the [adder area.

2.7.Editing in Fulf Screen Instruction List

Apart from the diagrams, the PLC program can be edited also in instruction
list editor. Setect the Change £ditor selection in Edit menu. if there are
diagrams in the working space, they are compiled to one instruction list and
the full sereen instructicn editor appears.

The editor js illustrated below:

B T R T o K X A R Y
e 3

Almost every instruction will include both an instruction cede field and an
instruction operand field. The instruction code must be entered first, since the
number of operands depends on the instruction used. Type in the instruction

and press , or use the function keys. After the instruction code field is
filled in, the cursor moves to the next field. which in most cases is the
operand field (if the insiruction does not include operands, the cursor moves
to the next instruction's instructicn code field). Fill in the operand(s) and then-
lype in the next insiruclion code. After several instructions, the screen will
appear as follows:

14
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The instruction fist is divided into four columns: the leflmost column is the
instruction number, column next to il is instruction code column, the next
column is the operand/address column and the rightmost column is the
symbol column.

You can move from the address/operand field to the symbol field with (f"i:":ﬂ'
{tab) or by moving the curser beyond the right end of address field. To move
from the symboi field back to the address field, hold the shiff key down and
press 8531, or move the cursor beyond the left end of symbol fieki. Press the

and {¥] keys to move from one instruction to another. Af the end of
instruction list there is always an empty instruction. When the cursor is there
and an instruction is typed, this insiruction is automatically inserted at the end
of the fist and an emply insiruclion added to the end of the list element.

To insert a new instruction into the middle of the list, move the cursor (and
the highlight) fo the {ine where you want the new instruction to be placed and

then press {ins). To delete an entire instruction hold the £Cuf) key down and

press Y ],

2.8.Editing Address Symbols and Comments

Symbol Table contains names and comments for PLC addresses. When
MinilLSS starts it lcads a default symbol table which contains symboeis (or
names) and comments for dedicated addresses, like clock puises, error flag,
comparison resuits etc. Besides dedicated PLC addresses there are also b
addresses dedicated to MiniLSS. These are discussed in chapter Compiling
Diagrams.

The default symbal table is ioaded from a file named SP16STD.STB in the
direclory where MiniLSS resides. You can customize this file by ediling the
symbol table and saving it with that name.

Symbols and comments for addresses are edited in the Symbol Table Editor,
To go from the Ladder Edilor to the Symbel Table Editor, selfect the Symbo!
Table item in the Symbols menu. The Symbol Table Eddor appears as
follows:
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The topmost fine is the menu bar. In LSS Mode the menu bar is absent, and
the menu can be called with T} M7 or fEnd).

The screen is divided into four columns. The leftmost column is the address
column. This is always automatically filled in by MiniLSS. The next column is
the symbol columa. Symbols can contain a maximum of 12 characters. The
third column hoids the comments. The fength of the comment fext depends
on the actual fength of the fext in printouis. MiniLSS uses a proportional font,
thus the number of characlers in comment will vary, depending on the widih
of the lettars usad. The rightmosl column is used 1o display the address state
in the PLC.

When editing symbols or comment texts you can use all normal line ediling
commands of MiniLSS. (See the chapler Line Editing Commands.) Symbol
or comment editing doesn't need to be ended by any special method; to edit
the next symbol or comment just move the curser to the desired field.

If undefined symbols are being used in the diagrams, they can be defined
simply by entering the undefined symbol next {o the desired address. This
causes the temporary undefined address 1o be replaced with the defined one
in all diagrams of the project. A fasier way s to use the copy pointer (see
explanation below). Undefined symbols will be discussed later.

In the Symbol Table Edilor you can copy selecled rows (both the symbol and
the comment}, the comment. or just one word, H lhe same comment s used
many limes it can first be copied 1o the copying buffer from which it can be
fetched H necessary

o poents can be coped with the help of the
vandd s qpven, e rowy that the pomter points
s coped o the current i aned e pomles moves 0 1he next row. Notn
that ff the current cow Do g cehned symbolb whoen e copy command
grven. the syinbol o ot coenvwatien The comment. however vall e

Sivlar o almost simlar groe s
Copy pomntec Whaoen a copy o

revstlien
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S ) When copying -is done with a copy. poiniéﬁ, the text to be copied can be
Ry i changed hy replacing -some:part of the text with another text string. for
example, if the following points are to be copied,

S1 Conveyor 1 position limit
. M1 Conveyor 1 motor

it can be specified that the '1' string is to be replaced with the string '2°. Then
the new points created by copying are

S2 Conveyor 2 position limit
M2 Conveyor 2 motor

’ -All the "1* characters of the original text will be replaced with a '2' character.

Keyboard commaﬁds: ,

Copy word from previous row. The word that is above the cursor is o
copied to the cursor position. Y

N .
Set the copy pointer to point to the current address. ET
Copy the row pointed to by the copy pointer {o the current row.
(Also replace and copy.) [‘f
| 2.9.Editing Diagram Comments
Comments are free-formatted explanation texts in a diagram. They can be
freely positioned in a diagram and are surrounded with a frame. The -amount
of rows inside the frame is unlimited. :
A comment is created by moving the cursor to a desired focation gnd
selecting Comments from the Element menu. The comment may be edited _
by simply positioning the cursor inside the comment frame. -
) i
Nt L

A typical edifor screen with ladder diagram, instruction list and diagram
comments appears as follows:

17



SECTION 2

S T

2.10.Line Editing Commands

When entering text, addresses, diagram comments, file names, ediling the
symbol table and so on, you can use all the line editing commands of
MinilL.SS. Line ediling commands are all the same with one exception: The
ine-end command may vary. Typically when entering data with more than
one row (as in the symboel table, or with a diagram comment). a field {or row)
can be ended just by moving up of down In cene-rove fields (e.g when

entering a contact address) the fieid must be ended with ihie
key.

PR

ngome Move cursor to the beginning of the field.

Move cursor 1o the end of the field

I Move cursor one character left
7] Move cursar one character right

Move cursor one word lef!

0 CUSO Oone veord oot

. e . . bt . PN . N cor g o vhe T T B
SMowe te the Despnmieey o e frebod e thiee oot N
Dl Porperie e oo e nibe poncs
; ; . .
Poivlarte 4y f1:i (RIS TR TR0 BN AT
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[« (Backspace) Delete the charactef‘t'o the lefl of the cursor.
fiC){T) Delete the end of the word.

Delete the end of field.

fcutiffomg Delete the beginning of the field.

fcid Delete the whole field.

z, Accept the field and stop editing.

fEsc Reject changes and stop editing. (Does not work with multiple-row
fields.)

Reject changes (retumns to the previous text) and continue editing.

[n the above list the concept of field must be interpreted broadly, as it
depends on the target of editing. It can be the whoie line (symbol iable,
diagram comment) or a separate field (contact address, file name).

18
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3.1.

3.2.

Files

SECTION 3

SECTION 3
Programming

Everything that is entered, ladder diagrams instruction [ists, diagram
comments, symbois etc. must be saved to file befere exiting MiniL$S. Each
program is referred lo by its name. The name can be a maximum of 8
characters long.

For one program Minil.SS will create several files which have different
extensions. (OGS file names have an 8-letter name and a 3-letter extension).
The following files will be created:

<name>.ND3 Ladder diagrams, instruction lists and diagram comments
will go to this file.

<name>.STB This file holds address symbols and comments. To retieve
your program from disk, .NDS and .STE files must both exist.

<name>.LOB This file contains the compiled program {o be downloaded

to the PLC. Also, uploading a program from the PLC produces this file.

<name>MNE This file is created during compilation. Usually, you don'
ever have to work with this file,

<name>.BND This is a backup file of previous .NDS file.
<name>.BST This is a backup file of previous .S3TB file.
When saving or opening a program file the file extension must be .NDS,

To restore the program from backup files, rename them {(BND to .NDS and
.BST t0 .STB)

Designing the diagrams

Before starting a new project, select the correct PLC type and set the LR-
Area size as needed. The LR Area seitings affect the number of available OR
words,

MiniLSS is intended o be used as much for the designing phase as for the
programming phase. The exact positions of contacts and other elements are
stored lo the project fite, and thair positions on the screen will neverchange
uniess you intentionafly move them. Syntax or fogical integrity is not required
uniil you decide to compile the program. This allows you to sketeh incomplete
diagrams, save the program and finish it at some other time. The use of
undefined address symbols are provided to help in the designing phase.

20
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3.4.1.

SECTION 3

Using symbols

Symbols are short declarations of address meanings. It is easier to remember
that "1st scan” stands for the very first program scan after power-up than o
remember that the address 0410 does the same.

MiniL.SS accepts symbolic addresses, like “1st scan® as well as absolute
addresses, like 0410. You may choose whether to use symbolic or absoluie
addressing, by selecting from the menuy (Symbols->Symbol Mode or in LSS
mode PROGRAMMING->Symbol Mode). The selected mode is seen on the
status line af the bottom of the screen.

Notel In LSS mode the symbols are only displayed, all input must be
absolute, in Minil.88 mode also the input can be symbolic,

If you select symbolic addresses, all addresses entered for conlacts are
symbolic. Thus if you enter text "0410" in symbo! mode, it is treated as a
symbol, not as address 0410. Symbol text is case sensitive: symbol 1s1 is
not the same as symbol 1S1.

You can define the symbols in the Symbol Table Editor before using them in
the Ladder Editor, or you can use them in ladder diagrams prior to defining
them. If you use symbols that are not defined, you will get a message each
time that you enter a symbot that has not yet been used. This wilt help you to
detect typing errors at the moment you make them. If you mistype the symbol
"1st scan” as “{stscan", you will get a message that a new symbol called
"Istscan” has been entered,

Undefined symbols are assigned an address, called an Undefined Address,
that begins with the letters Ul foliowed by a unique sequence number. These
Ut addresses do not have any corresponding addresses in the PLC and they
must be replaced with real PLC addresses before compiling.

Using undefined symbols'is useful when sketching diagrams. When changing
diagrams. deleting portions of them or inserting other portions, you don have
to determine which real PLC addresses are needed. When you end up with
something useful, you can see how many addresses are reaily needed and
assign those to the real PLC addresses.

Using the clipboard

The clipboard is a temporary storage where, you can store portions of
diagrams or instruction lists. in one time, the clipboard holds only ladder
elements or only instruction lines. Note that a whole instruction list element is
a tadder element and can be copied together with other ladder elements, but
a portion of an instruction list element (i.e. one or more instruction lines) is its
own type and can be copied only inside an instruction iist element or from
one instruction fist element into another.

Copying, cutting and pasting diagram portions

First select the portion to be stored by marking the area. To start marking,
position the cursor at the top lefi comer of the area to be marked:

21
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SECTION 3

Then seiect Mark from the £dit menu (or in LSS mode MARK from the
PROGRAMMING menu), or if you are using a standard keyboard, hoid the
shift key down and move the cursor (o the opposile corner of the area:

To copy lhe marked area Lo Whe cliphoard, select Copy from the Edit menu {1
i LSS mode COPY from the PROGRAMMING menu). The Copy commang

feaves the ongmal diagrams untouched I vou select Cuf the ongias!
diagrams nsde the marked srea wiil be delelea

Porcapy datir Trom the Chit o miove M Cofset (0 800 100 et e af
tleshnabion aren
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select Pasfe from the Edift menu (or in LSS mode PASTE from the
PROGRAMMING menu). If there is enough free space in the diagrams,
contacts from the clipboard will be inserted:

iy

Note that pasting from the clipboard does nol alfect the positions of contacts

exisling in diagrams. You have (o make encugh room to fit the cliphoard data
in by yoursetf.

3.4.2. Copying, cutting and pasting instruction lines

Notel Instruction list elements are not supported in LSS mode

Copymg mside an mstruchion list element or m (ull screen mstruction cdior

foltlows the same procedure as copying trom a ladder diagram area

However, copying from an instruction st (il (he chpboard with indovidual

instruchinns and these gannol be pasted dweclly to the diagram area H you

wanl 1o copy an enlire msteuclion st element, mark the area outside of the
g rstruchion st frame and Copy das you waulkd olivwer dragiam elements
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Belore copying the arca (o be copied must Lo earkod To stan marking,
move the cursor o lop of desired area and seloct Mark from the it meniu
{or in LSS mode MARK from the PROGRAMMING meny), or bold the shuft
key down and move the cursot to the last ine to be ncluded 10 (he area:

Select Copy from the Edit menu {or in LSS mode COPY from the
PROGRAMMING menu). This causes instructions inside the marked area o
be copied to the clipboard. The original instructions are notl touched in a Copy
operation. |f you select Cut, the original instructions inside the marked area
are deleled. After a Caopy or Cuf command. the area selection is removed.

FAove Ihe cursor to e 1ocation where you want o mnert imsituChons (rom the
chiphonrd and select Pasie from the oweme Instruchiogs fiom e clipbonng vl

L

secwebed b e Dt oo e cnel ol e e went eogneied doven o e
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3.4.3.

3.4.4,

Clearing

SECTION 3

diagranm area you must make room to insert data fiom e chipboard, butin an
instruction list MiniLS$ does il for you.

You can also clear the marked area by selecling Clear from the Edit menu {or
in LSS mode CLEAR from the PROGRAMMING meny). This command
clears the marked area and does not save it to the clipboard. Cleared dala
cannot be retdeved in any way. (Use the Cuf command if you need 1o
retrieve the data later from the clipboard.)

Converting program format with the clipboard

Notel Instruction {ist elements are not supported in LSS mode

The clipboard can receive data in two formats: ladder diagram format and
insfruction formal.  You can convert ladder diagrams 1o insiructions by
copying them onto the clipboard and by then pasting them into an instruction
list element. {f the data format is to be changed! direct pasting 1s nol allowed
instead you must seiecl Conver? & Paste from the F£dil menu. Converting will
succeed onty if the diagrams are syntactically comrectl. Logical inlegnly 1S aiso
required. Logical integrily means that ali conditions (contacts) will end 1 an
oulput/funcionftimer/counter

To convert from ladder diagram to mstruction lisl, first mark the area
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15

Select Convert & Paste from the Edit menu. H lhe marked area
synfaclically correct, the corresponding instruction list block is insarted into
the inslruction st element’
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ke

To convert from instruction {ist format to ladder format, first mark those
instructions to be converled. Note that the instruction list must be logically
whole: the last instruction must be an output-like instruction, each branch
stanling with an LD/LD-NCT instruction must end with outputs, elc.

Move the curser o the top of the desired area and selact Mark from the Edif
meny, or hold the shift key down and move the cursor to the last line {0 be
included in the area:

i

G
S Srssnts
«'f}%é%‘& SE

2 (f.; G 4
e,

select Copy lrom the Fdi meny Move the curson i ithe diagram arca o the
top ledt corner of the grea where the ladder alements are to be mserted, and
select Converd & Paste from e Fdil imenu

2
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It the fogical integrity of the mstruction list copied onfo the clipboard is not
correct, those circuits found o be complete wail be converted to ladder
diagrams, and the rest of the instructions will be changed {0 new inslruction
iist elements. For example, the following instruction list is nol logically
integraf:

The part converted to an instruction fist has no ciect on outputs and cannot
be localed to a diagram area

3.4.5. Saving the clipboard to a fite

Onee the datas coped oo e chpboard o cin o ived oo onnb

Bled vse You can cnlioat guenn PEOOray w1
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3.4.6. - Loading the clipboard from a file

The contents of the clipboard can be loaded from a disk file by selecting Lcad
Clipboard from the File menu (or in LSS mode SAVE CLIPBOARD from the
FILE MNGT menu). A window will pop up asking for the file name. Enter the
filename or select the filename from a pick fist. Pick list will appear if you
specify a file name with wildcards, e.g. *.CBR.

Once the filename is given, the contents of the clipboard are joaded from the
disk file. When the loading is complete, an Address Exchange Editor window
will appear. Change the desired addresses and exit from the Address
Exchange Editor (see the next chapter for using the Address Exchange
Editor). Pasition the cursor and paste the data from clipboard as described
earlier.

3.5.  Using the Address Exchange Editor

The Address Exchange Editor can be used to change addresses of entire
program, marked area or clipboard. To change addresses of the entire
program, seélect Change Addresses from the Edif menu (in LSS mode
CHANGE ADDRESSES from the PROGRAMMING menu), to change
addresses to a marked area only, select Change Area Addr from the Edit
menu (in LSS mode CHANGE AREA ADDRESSES in PROGRAMMING
menu). Clipboard addresses can be changed just after the clipboard is
loaded from a file. The Address Exchange Editor window is illustrated below:

-

IOV Lo 0 Ly A v - b
e At oAl IR 7 loay 7 53 7 LT R TR

L Toptine is the menu bar. In [.SS mode the menu bar is absent and the menu

can be cafled with or

L4

Original addresses, symbols and comments are shown in the left side of the
window. In the right are two columns where new addresses/symbols can be
defined. The {eftmost of these columns is the address column (highlighted in
the picture above), the rightmost is the symbol column. You can move the
input focus between these columns with the tab key. Fill in the new desired
address or the symbol to the hightighted field. The comment of the new
address is shown in the window called "New address". In the picture below,
one new address is entered:

29
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Fdbin all these addresses that you want o change Il the new address s lofl
blank, the original address vail not change Thus if Ihe editing is terminated
i a screen ilustraled above. only the address ORC001T valf be changed. and
its new address will be DROGO3 All other addresses will remain the same

All menu sefections are shown below:

Notel In LSS Mode the menu will ook different. See chapter £.5S Mode
Menus for details,

MENUBAR SELECTIONS

Exit

Copy Addr

Addr by Symbol

Copy&Replace

titils

Syinbol Thi

Asks for a confirmation and if accepted changes
addresses and closes the window

Copy the original address (o new address

Find an address which has same symbol than {he
original one. Relevant only when handling a
clipboard that is leaded from another program

Take the onginal address/symbol, replace par of #
as specified by Utils-»Set Copy/Replace and sel i
as the new symbol/addrass. If the cursor is in
addiess column address sinmng will be modified. i
the cursar s i symbial columan. symbaol text wall be
modidfied

Crens Unls sotmen

Lels wia ot svennbe s tnbin ot

UTILS SUBMENU SELECTIONS

Copy Conuneni X Sy

RS

I i

DLy ONG D Sy st Lo e Symibeod
LMY perabios o7 e s Relevant ony
wehinn Bindling e loaded Troan

Fother o n
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Set Copy/Replace

Wilh this command you can define 3 string which
will be replaced by another string when capying.

-
it
<l
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SECTION 4
Printing Documents

4.1.Choosing the printer

4.2. Orientation

MIniL.SS supports printers which can emulate those in the following list:

HP LaserJet+
HP Laserdet ||
{BM Graphics

It is assumed that you are normally using a laser printer. However it is
possible to make smail printouts using a matrix prnter. Check that your
printer has cne of the suppored emulations and find out from the printer
manual how that emulation is chosen.

The printer selection is made from the Options menu:

The parallel port where the printer is connected must alsc be set. That
selection is available in the Cpfions menu:

tort the goquonzo whon otart ! PO,
uu“m AN oa't‘o mmlenu\w. tlmh:nvn?.“u‘ann% oy
Vwmmmm

Note: Orientation is only available for laser prnters.

Page orientations can be selecled as either porirail, landscape or mixed.
Portrait orientation allows more lines 1o be drawn, and fandscape orienlation
ailows longer lines to be drawn.

32
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Portrait ) / ’ _
Landscape E
ot
i -4*4%{—41%)
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ey e,

If you want only portrait pages, select Portraif on the (Options->Page) menu.

A page orentation can be set from the Options menu, with the Page &
selection. The Page menu appears as follows:

JMI”MWW%JW el
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[n portrait mode it is not guaranteed that the lines will fit on the page; i.e., you
can draw longer lines with the editor than there is room on the paper.
However, if long lines are detected, the page will be printed on two or three
sheets, divided vertically: '
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Both pages share the same page number, ’

If you select Landscape from the menu, there will only be landscape pages, l
no matter how wide or narrow the diagram is: ¢
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If Mixed is selacted from the menu, there will be both portrait and landscape
pages, depending on the width of diagrams. All diagrams that can be printed
with portrait will be printed with a portrait orientation, the rest wiil be printed
landscape:

34



’r

4.3.Page Length

4.4, Headers

SECTION 4

Page length can be set separately for porirail pages and landscape pages.
There are two setlings for both modes: Maximum Page Length and Minimum
Page Length. The Maximum Page Length defines the maximum amount of
print lines that are used for diagrams. The lines needed for a Header are not
included in this length.

Minimum Page Length defines a page breaking zone. MiniLSS {ries (o make
the page break on an empty line, as near to the defined maximum page
length as possible. If there are no empty fines between Minimum Page
Length and Maximum Page Length, the page will be cul on the line at
Maximum Fage Length. So, the page length will never be greater than the
Maximum Page Length, and with one exception never smaller than the
Minimum Page Length. The exception takes place in mixed print mode:
switching from portrait to landscape may produce a porirait page that is
shorter than the Minimum Page Length.

A header file is a separate freely-formatted text fite, the contents of which are
defined by the user. This is done with any text editor that produces a DOS
text file. An editor is not supplied with MiniLSS.

In & header file you can use semi-graphic marks to draw lines and boxes.
When editing a header be sure that you don't make it too farge (too many
lines). This may cause overprinting {output continuing onto the next page).

When printing the first page MiniLSS will search for a header file named
<project>.HDR from your hard disk. If this fiie is not found, MinilL.8S uses a
standard header file delivered with MiniLSS. The name of the standard
header file for laser printers is LASER.HDR and for matrix printers
MATRIX.HDR. If the default file is not found, MiniLSS will display an ermor
message and prompt for a new file name, If a selection is not made (you

press fEsc)), no header is included in the listings.

4.4.1, Listing Codes in a Header File

In a header file references to a project to be listed or the time of listing can be
made with text codes. The text code is replaced with the comesponding
information when it is printed.

All the text codes are described in the foliowing list:

H This code is replaced with an outpu! type: for example, 'diagram’,
‘symbeot table’, etc.

3P increasing page number.
$F Name of the project file,
3D Date. This is fetched from the PC's calendar.

1
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ST Time. This is felched from the £C's clock.

The foliowing codes correspond to the data which is entered into the project
information window (the project information window is accessed from the E£dit

Mmeni) :

$A Name of the designer.
$C Project description,
5R Version number,

Besides these predefined text codes, a user can define his own codes to be
inctuded in a header. A user code is included in the header by wriling $<code
number>. The code function must be defined before it is used, What is more,
the code must follow the syntax required by the emulation of the printer; e.q.,
HP Laseret+.

The definition of a user code starts from the beginning of a line. The first
character must be ' (a brace) and then $<code number><SPACE>. After
<SPACE> is the control code. The structure of the user code is:

{$<code number><SPACE><control code>

In the control code for listing operations you will often use characters which
can't be written with a text editor (for example <ESC>). This is solved by
making it possible to wrte both normal characters and ASCI codes for
characters in the control code. The syntax of code requires that texts with
normal characters are separated with a single apostrophe (); ASCIl codes are
written one at a time and preceded by a % mark: each field must be
separated from the others by a comma ().

For example:
{$3 #27,7)508" #14,'Company Name' #15

For more information on printer control, refer to the corresponding Prinler
Manual.

Header Alignments ‘

All tistings are sent to the printer proportionally ({aser printers). This means
that the print head moves a distance relative to the width of a character: i.¢.,
the 1" character width is shorter than the 'x' character width. This may cause
difficulties when aligning a header file; characters intended to be positioned
below each other are not printed in the same position as they appear on the
screen. With semi-graphic characters this problem does not exist; their widih
is always the same, and during prnting there is a check that the printing
posilion equals the position on the screen.

Alignment can be made with help of a marker (ASCH code #173), L is
represented with an upside-down exclamation mark on the screen. A marker
is printed as a <SPACE> character, and it moves the print head to a position
thatl equals the position on the screen,
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Besides being used in headers, the mdrker may be used in diagram
comments, whege it can be insered with the function key [F2).

+
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SECTION 5

SECTION 5
Inside Menus

5.1.L.adder Editor Menus, MinilLLSS Mode

5.1.1. Files

Open

Save

New

Dos Shell

Prirt

Load Clipboard

The File menu is used to foad and save diagrams, to print diagrams and 1o
exit the program.

Loads diagrams from disk. After selecting this, a smali window pops up
asking for a filename. If you enter a filename with wildcands (e.g. *NDS), a
second window appears with a pick list where ail matching filenames
currently found on disk are dispiayed. To load diagrams, two files assigned {o
{he filename must exist: <name>.NDS and <name>.STE. Note that diagrams
(files with extension .NDS) and Symbol Tables (files with extension .STB) are
aiways retrieved and saved together.

Saves diagrams and Symbol Table to disk. After selecting this, a small
window asking for a filename appears. The window may have a defauil -

filename already filled in. To accept the default name, just press {i ,ﬂf?r;

otherwise fill in the required name and press 5@ As with the opening file
procedure, if you enter a filename with wildcards, a pick {ist with matching
filenames wilt be displayed. If you save a file with the same name as an
existing file, the file originally on the disk will be overwritten. In this case you
are asked for confirmation, to prevent accidentally overwriting other files.

Clears the working space and foads the default symbol table. Any changes
made since the last save operation will be iost.

Lels you go to 0OS, leaving the program and diagrams in memaory. To retum
back from DOS type EXIT at the DOS prompl. When returning, make sure
that you are in the same directory.

Opens the Prant submenu

Loads the clipboard contents from a disk file, previously crealed with Save
Clipboard command. Affer selecting this, a window asking for filename
appears. As with the other file procedures, if you enler a filename wilh
wildcards, a pick list with matching filenames wili be displayed.

Use Save/Load Clipboard when Merging programs.
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Save Clipboard  Saves the clipboard contents (o a disk file. After selecting this, a window
asking for filename appears. As with the other file procedures, if you enter a
fiiename with wildcards, a pick list with malching filenames will be dispiayed.
Use Savefload Cliphoard when menging programs.

Copy File tets you copy files, one at a time.
Rename File Lets you rename files, one al a time.
Exit Terminates the program and retums back to DOS. If you have made any

changes since last file save, they will be lost. In this case you are asked o
confirm exiting,

The Print menu tets you select the items to be printed.

L R
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Diagrams Prints alt diagrams and instruction lists.

Symbol Table Prints the Symbol Table. Cnly those addresses will be printed that have
symbois or comments attached.

Used Memory Areas
Print those addresses that are directly used in the program.

All Print diagrams, symbol table and used memory areas.

The Edit-Menu
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i fl(‘“ W Gl

2?" _ v A 8
3///%%%% |

o
I I NE

Mark Marks the area o be copied/moved to the paste buffer. Marking can also be
done by pressing the shift + cursor key with a normal PC keyboard.

Copy Copies the marked area tc a pasie buffer.

Cut Moves the marked area {o a paste buffer and removes if from is original
location.

Clear Ciears the contents of marked area, does not affect the paste buffer. Note:

there is no way (o get the cleared data back.
Paste Fastes the data from ihe paste buffer to the cursor location.

Convert & Pasfe  The paste buffer can contain ladder diagrams or instruction lines. Use this
command to converl instruction lines 1o ladder diagrams or vice versa.
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5.1.3.

Change Addresses

SECTION 5

Open the Address Exchange Edilor wilh 50 the addresses {ound in e
program

Change Area Add Open the Address Exchange Editor wilh all the addresses found in (he

Froject Header

Change Editor

marked area

sets generat information about the project: Author, Project Name and Version
ID. These texts will appear in the listing header.

Toggles between the full-screen instruction editor and the diagram editor.

Diagram Elements

~
N\

Vertical short

—0
__®

FUN( )
TIMER
COUNTER
Address

Pick Address

Comment

Fage Break

insitruction List

P Ao o

Draws an open contact to the cursar position.

Draws a closed contact to the cursor position,
Draws a horizontal short to the cursor position.

Draws vertical short to the cursor position.
Draws an output to the cursor position.

Draws an inverted output to the cursor position.

Lets you specify the function and draws it tc the cursor position,

Draws a timer {0 the cursor position.

Draws a counter to the cursor position.

Lets you specify the address of 3 oontact/out'put.

Picks the current address from the Symbol Table and assigns it to the contact
undemeath the cursor. The current address is the one where cursor was at

your last exit from the Symbei Table Editor.

insens a diagram comment at the Cursor nosition
(Shorteut key for comment is "C™)

Inserts a page break at the cursor position

nserls an instruction list element at the cursor position
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5.1.4.

5.1.5,

5.1.6.

Download

SECTION 5

Scarching

Search Bit £ ddress  Lets you enter a bit address and searches for its first occurence starting
from the cursor focation. All contacts, oulputs, functions and instruction lists
are searched.

Search Wors Address Lets you enter & word address and searches {or its first occurence
stading from the cursor focation. All contacts, outpuls, functions and
instruction lists are searcired.

Search Instr ,  Lets you specify the instruction and optionaily, its operands. If an

Operandfaddress is left blank, any operand/address fuifilis the crtera.

Search Next Searches for the next occurence of an address/instruction previously given

with the Search Bif Address, Search Word Address or Search (nstruction

selections. (Shortcut key for Search Next is "N")

Gofo Line

Positions the cursor at the line specified.

Compiling

Diagrams -> Obj Compiles diagrams to a PLC object code file. The obiect file will have an
LOB extension and can be transferred to the PLC.

Obj -> Diagrams ~ Compiles an object file to diagrams. The object file is created by uploading
the contents of the PLC memory in the PLC menu.
Compare Compares currently loaded diagrams with an object code file.

Mnemo To Screen Compiles diagrams to the screen window. All syntax checks will be
performed.

PLC Utilities

.
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Type Cpens the PLC selection menu.

Downloads an LOB file to the PLC.
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5.1.7.

5.1.8.

Upload

Monitor On

Multimonitor

LR Size
Fiiters
Sel/Reset Bit
Wiite Word
PLC Mode

Disconnect

Symbols

Symbol Table

Symbol Mode

Options

Screen Size

Senal Port
Paralle! Port

Printer Type

SECTION 5

As

Uploads contents of PILC program memory.

When monitor mode s on, the statuses of PLC addresses are shown in
diagrams. (Sorcut key: “M")

Opens a multimonitor page where statuses of several PLC addresses are
shown.

Sets the LR size.

Sets the values of input filters.

Forces specified bit ONJOFF (Sortout key: "B"

Changes the value of a word address in the PLC.(Sortcut key; "W"
Lets you sef the PLC o RUN mode and to PROGRAM mode

Once you have established a connection to a PLC, you can not change the
PLC number uniess loading another program or selecting Disconnect,

R

(f o

7,
! . ] -3
8 275% g WL
: .f’fs.xfhme:‘.f%?;w.ﬁffé

Go to the Symbol Table Editor.

When the symbol mode is on, the symbols (or names) of addresses are
displayed instead of numerical addresses. (Sortcut key: "M™

Lets you select the screen height:25 lines or 43/50 lines {43/50 is preferable if
your hardware supports it).

Lets you select the serial porl te be used: COM1 or COM2.
Lets you select the port where the printer is connected: LPT1/LPT2.

Lels you select the printer type.
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Backups

RS

LRl

SECTION 5

- When this option is on, the old files will be saved when storing diagrams.  ~

Extensions for backup files are .BND for the diagram file and .BST for the
symbeo! table file.
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Justily Qulputs

Keyboard
Fage

Save Seflings
LES-Look

Colors

SECTION 5

Display the outputs, timers, counters and functions justified to right edge of
the screen.

Lets you select the typematic delay and the lypematic rate of your keyboard.
Lets you select the length of the paper used as well as its orientation.

Saves the current seitings to a disk file in the current directory.

Change the program outiook to LSS-style

Specify the screen colors

5.2.  Ladder Editor Menus, LSS Mode

Programming

Mark

Copy

Cut

Clear

Paste
Comment
Page Break
Gofo Line
Symbol Tabie

Symbol Mode

Change Display

Marks the area to be copied/moved to the paste buffer. Marking can also be
done by pressing the shift + cursor key with a normal PC keyboard.

Copies the marked area to a paste buffer.

Moves the marked area to a paste buffer and removes it from ifs onginal
location.

Clears the contents of marked area, does nat affect the paste buffer. Note:
there is no way to get the cleared data back.

Pastes the data from the paste buffer to the cursor location,
Inserls a diagram comment at the cursor position.

[nserts a page break at the cursor position

Positions the cursor at the line specified.

Go to the Symbo! Table Editor.

When the symbol mode is on, the symbols (or names) of addresses are
displayed instead of numerical addresses.

Toggles between the (ull-screen instruction edilor and the diagram editor.
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5.2.2.

5.2.3.

e

SECTION 5

v

Change Adcresses  Open the Address Exchange Editor with all the addresses found in the
program

Change Area Addresses
Open the Address Exchange Edilor with all the addresses found in the
marked area

Search Opens the Search submenu

Search

=

Bif Lets you enter a bit address and searches for its first ocourence startiag from i
the cursor location. All contacts, outputs, functions and instruction lists are

searched. ¢

Word Lets you enter a word address and searches for its first occurence staring L
from the cursor location. All contacts, outputs, functions and instruction lists

are searched. }?*5

o
Instruction Lets you specify the instruction and optionally, its cperands. If an

operand/address is left blank, any operand/address fulfills the criteria. =

Next Searches for the next occurence of an address or instruction previousty given i

with the Search Bit, Search Word or Search Instruction selections. .

When PLC Connection is ON

e X

The PROGRAMMING menu will change when you set the PLC connection
on. The menu will appear as following: .

Download Cownloads an .LOB file {o the PLC.

Upload Upioads contents of PLC program memory.

Multimonior Opens a mullimonitor page where statuses of several PLC addresses are
shown.
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LR Size Sets the LR size. . 7
Fifters Sets the values of input filters.
Sel/Reset Bit Forces specified bit ON/OF#.

Write Worg Changes the value of a word address in the PLC,

9.3.  Symbol Table Editor menus, MiniLSS Mode

5.3.1. Edit Menu

RRY I e e s // —/"/ S a7

e Y ¢ & it 7
5 2 Z :
Syt = / v

Set Copy Pointer Sets the copy pointer to the current line. A small arrow left in the symbol
column marks the position of the COPY pointer.

3
N

Copy From PointerCopies from the line specified by the copy pointer to the current line and
: moves the copy pointer one line downwards

Set Copy/Replace With this command you can define a string which will be replaced by another
string when copying.

Copy Comment  Copies comment text to the paste buffer

Faste Comment  Copies comment text from the paste buffer to the curent line.

5.3.2, Goto Menu

LA

TERE

2

Goto Bit Address  Moves the cutrent line {o the bit address specified.
Goto Word Address Moves the curent line 1o the word address specified.

Pick Address Opens a pick window, where recently searched addresses can be selected.

5.3.3, Search Menu

46



rr

SECTION 5

T T A
Vi & Wm?é/

O AR

W
e
fﬁ/,] e
50 3 %

? CAY I o,
; ’,/) %’ g?/ga L r?'%//{
P

Search Symbol  Search for an occurence of text in symbol texts.

Search Comment Search for an occurence of fext in comment texts
Search Next Repeat the last search.
Show Used Addresses

Create a cross reference and indicate addresses that are directly
used in the program.

5.4. Symbol Table Editor menus, LSS Mode

S PaCCOCEOBBEET

Set Copy Pointer  Sets the copy pointer to the curmrent line. A smali arow left in the symbol
column marks the positicn of the copy pointer.

Copy From PointerCopies from the line specified by the copy pointer to the current line and
moves the copy pointer one line downwards

Set Copy/Replace With this command you can define a string which will be reptaced by another
string when copying.

Copy Comment  Copies comment lext 10 10 the paste buffer
FPaste Comment  Copies comment text from the paste buffer {o the current line.
Goto Bif Address Moves the currert line o the bit address specified.

Gotfo Word Address
Moves the current line to the word address specified.

Search Opens the Search submenu

Show Used Create a cross reference and indicale which addresses are directly
used in the program.
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541, Scarch submenu

Symbol Search for an occurence of lext in symbo! lexts.
Commen: Search for an oceurence of text in comment texts
Next Repeal the last search,

5.5.  File management menu, LSS Mode

Cpen Loads diagrams from disk. After selecting this, a small window pops up
asking for a filename. I¥ you enter a filename with wildcards (e.q. *NDS8), a
second window appears with a pick list where ail matching filenames
currently found on disk are displayed. To load diagrams, two files assigned to
the filename must exist: <name> . NDS and <name>.5TB. Note that diagrams
{files with extension \NDS) and Symbol Tabies (files with extension .STB) are
always retrieved and saved together.

Save Saves diagrams and Symbol Table lo disk. After selecling this. a smali
winddow asking for a filename appears The window may have a defaull

ficname already filled in. To accept the defaull name, just press {LE:”L‘”;

ctherwise fill in the required name and press VEEEF_ As wilh the opening file
procedure, if you enler a filename with wildcards, a pick list with matching
filenames will be displayed. If you save a file with the same name as an
existing fie, the file originally on the disk will be oveiwnilen In this case YOuU
are asked for confirmation, 1o prevenl accodentaliy overwnting other files

Nz Clears the working space and ioads the defaull symbol alde Any changes
made wince the 1081 save operation will be fost

Shett Lets you go to DOS, leaving the program and diaarams m maensiy To relunn
back tromy 3OS Iype EXIT af the DOS PEOIMP

P Openy ithe Pond subumene
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Load Clipbozrd  Loads the clipboard contents from a disk file, previousiy created wilth Save
Cliphoard command. Afier seiecting this a window asking for filename
appears. As with the other file procedures, if you enter a filename with
witdcards, a pick list with matching filenames will be dispiayed.

Use Save/Load Clipboard when merging programs.

Save Clipboard  Saves the cliphoard contents to a diskfile. Afler selecling this a window
asking for filename appears. As with the other file procedures, if you enter a
filename with wildcards, a pick list with matching filenames will be displayed.
Use Save/l.oad Clipboard when merging programs.

Projécr Headar  Sets general information about the project: Author, Project Name and Version
ID. These texts will appear in the (isting header.

i

Compile -> Dgrs Compiles an object file 1o diagrams. The object file is created by uploading £.

the contents of the PLC memory in the MON&EDIT menu.
Compile -> Obj  Compiles diagrams {o a PLC object code file. The object file will have an

LOB extension and can be {ransferred to the PLC.
Compare Compares currently loaded diagrams with an object code file,
Copy File Lets you copy files, one at a time.
Rename Fiie l.ets you rename files, one at a time. ; A
LSS -> MINILSS Changes the program outlook to MiniLSS-style: fir

Frint submenu has the foliowing selections:

POREREN DA -
v 1 o By
siviey {4
00 B
ik "‘E ¥
Ty ot B
G010 i i
Gais i
g8ia
+ i 0
¥ ) 2

Diagrams Prints all diagrams and instruction fists.

Symbol Table Prafs the Symbol Table. Only those addresses will be prinled that have h

symbols or comments aftached.

Used Addresses
Print those addresses that are directly used in the program.

All Print diagrams, symbol tabie and used memory areas,

Setup menu, LSS Mode
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PLC Type

Screen Size

Serial Port
Parallel Port
Frinter Type

Backups

Justify Quiputs

Page
Screen Colors
Save Setup

Exit

SECTION 5

BiStEtIE yReniEs s SRRATA

Opens the PLC selection menu.

Lets you seiect the screen height:25 lines or 43/50 tines (43/50 is preferable if
your hardware supports it).

Lets you select the serial port to be used: COM1 or COM2.

Lets you sefect the port where the printer is connected: LPT1/LPT2.

l.ets you select the printer fype.

When this option is on, the oid files wili be saved when sloring diagrams.

Extensions for backup fites are .BND for the diagram file and .BST for the
symbol table file,

Display the outputs, timers, counlers and functiens justified to right edge of
the screen,

lets you select the length of the paper used and its orientation.

Lets you edit the screen colors used.

Saves the current settings to a disk file in the cumrent directory.

Terminates the program and refums back to DOS. If you have made any

changes since [ast file save, they will be lost. In this case you are asked to
confirm exiting.

L0



SECTION 6

Online Properties

After a program is compiled and transferred to the PLC, you can observe the
states of the PLC's memory locations with the help of monitoring features.

SECTION 6 E
Monitoring requires that the PLC be connected to a PC or 1o a Link Unit with
a special SP° cable. g
in monitoring mode you can observe diagrams in the Online state, where the
states of memory locations in the PLC are displayed on the screen. You can
also scan through the symbol table in Online mode, where the states of points
are displayed.

Sometimes it is necessary to observe several PLC addresses simuitaneously, _
aithough they are contained in separate diagrams. This can be done with the v
help of Multimonitoring Pages. You can collect one screenful of points (bits

and words} into these pages from various memory areas of the PLC. These ”
pages can also be saved to a file frem which they can be retrieved if needed. e

6.1. Monitoring a Diagram

Diagrams are monitored directly from the Diagram Editor. From there
monitoring is started by selecting Monitor On in the PLC menu.

In L8S-Mode, the PLC connection is made by pressing f£Ctd)§0). The
function key guide changes to following:

Press to establish connection to PLC.

If monitoring is begun for the first time during the current working session,
MinilL58 prompts for the number of the PLC (o connect with, This number
(0..3) depends on the location of the PLC communication cabie in the Link
Unit. #f no Link Unit is used, the PLC number is 0. Once the PLC number is
sel, it can be changed only after toading a different program file, or after
seiecting Disconnect.

The 1-state of a PLC's bit address is represented with a brighter color than
the O-state of the address (with defaull color seltings). Word values are
disptayed to the right of operands:
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The contents of PLC addresses can be changed in Monitoring mode with the
selections Set/Reset Bit and Write Word inthe PLC menu. In LSS Mode the
menus are different, See end of this chapter for LSS mode menus.

After selecting Set/Reset Bit a window opens at the bottom of the screen
asking for the bit address. If the cursor is over a contact when selecting
Set/Reset Bif, the default address is the address of that contact; otherwise
the default address is the address that was last set;

Urrelaang . Addreuaco

Fill in the required address, or to accept a default address, press 5_1155” The

address can aiso be entered as symbolic by adding a '/ in front of the symbol
The window changes. now displaying the address and its current state:

By pressing £8 ] the bit is forced on and by pressing fR] the bit is forced off

Note! When changmg vaiues, the new value 1s oty written once into thoe
PLTC There nodung o prevenl the PLE from automatically changing e,
value

Mote! B vales are wntien word based: contents of the word are read (he i
wrquestion s changed and the whole word wilen back Lo tho RLC 11 L
progranmy has changed other bils in that wore m between read and v
operation, states of those bits are restored bhack w their states at read tune
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Writing word values is begun with the Write Word selection in the PLC menu.
After this selection a window appears at the bottom of the screen, asking for %
the word address. Afier enlering the address, the window changes and ¥
dispiays the word address and ifs current value. Enter the desired value into

the input field and press . The new value is wiitten to the PLC.

Note! When changing values, the new value is only written once info the

PLC. There is nothing to prevent the PLC from avtomatically changing this e

value.

;

In LSS Mode the PROGRAMMING menu changes after the PLC Connection

is established. The menu wili look fike the following:
He,

6.2. Monitoring the Symbol Table

The Symbol Table can be scanned in Online mode where the value of every
PLC address is displayed in the rghtmost field of the Symbol Table.
However, MiniLSS cannot be set to Online mode from the Symbol Table -

this must be done from the Diagram Editor.

Bit addresses are represented with four ** marks, which grow brighter in the
bi's 1-state, and grow dimmer in the 0-state. The values of channel
addresses are represented by numeric strings.

6.3. Multimonitoring Pages

A Multimonitoring Page is accessed from lhe Diagram Cditor with the
Multimonitor selection in the PLC menu. If a conneclion has already been
established, MINILSS will automatically switch to Online mode, and when
retuming (o the Oiagram Editor the previous Online/Offline mode will be



SECTION 6

reinstated. 1o there is no connection, Muiiimaondaing Pages may be scannea
and ediled in Offline mode.

6.3.1. Structure of a Multimonitoring Page

A Multimoniloring Page is illustrated below.

QT INING o eIl 1T S
Flie Edit Foumcwd, Lix tae Dettl P LA Comrmm b TR amabol Tl e Yiw g

A Multimonitoring Page reserves the upper half of the screen if the screen is
set to 43/50 line mode, or the whole screen if it is set 1o 25 line mode.

The name of the Multimonitoring Page definition file is displayed in the upper
feft-hand comer. The upper right-hand comer notifies whether a connection to
the PLC exists or not. If the connection is fost for some reason, the states of
the displayed points will nol necessarily indicate the actual stales of PLC
addresses,

The next row is the menu bar. The menu bar can be accessed wilh the {Esc]

key or by holding the key down and pressing any of the highlighted
characters.

in LSS Mode the menu bar is abseni, and the menu can be calied with

fCui)f ™M) or fEnd).

In .S Mode when the menu is displayed, the screen appears as foliows:

Ot OO T2
el

T R A S

I ITSRNETITY, R R R R S E S R AN A REALs cast) o ps s A

Note that even (hough the menu selections descnbed in this chapler are
bhased on MiniLSS mode. the same commands ¢can be achieved also in LSS
menu when LSS mode is selecled.

The rest of the acea s reserved for definmyg addresses o be mondtored
Addresses,  symbols  and  comments  are displayed here A Hilled
Motimaomlonng Page appears as follows
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Editing a Multimonitoring Page

A Multimonitoring Page is edited by inserting new addresses to be monitored.
These can be defined by their absolute addresses or by symbolic names.
Inserting addresses is staded from the Edif menu:

A window will pop up asking for the address/symbol. When the address has
been entered, it will be placed in the highlighted line.

The address in highlighted line can be decremented by pressing fCu)f<),
and incremented with Cu)=3). With Cul)#gUd you can insert a preceding

succeeding address balow the highiighted hine

A ready-made Mullimonitoring Page can be saved lo disk for later retrieval
Saving and loading a Multimonitoring Page file are simifar operations (o the
saving or loading of any other MiniLSS fhiec The Mullimeniloring files have
the extension .MMF. The last crealed page will retain its data unless il s
changed, a new page is loaded, or if MiniLSS 1s exited The Diagram Fditos
and Symbol Table can be used without a need to wrile the page agan
Saving and loading MMF files 1s started [rom (he File seleclion:
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Fareturn back Lo the Diagram Ediler choose Fxd from the File mena

Hr
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6.3.3.

6.3.4.

SECTION 6

Changing PLC states in the Multimonitoring Page

The contents of the PLC memory can be changed with seleclions in {he
Forced Write menu. The menu appears as foliows:

32K KSR e rreestpee, 0
I L e i 3 i e

The procedure for Set/Reset and Write Word commands are simiiar to those
in the Diagram Editor. See chapter Monitoring a Diagram.
Setting LR Area Size

The LR area size can be set in the Multimonitoring Page, or directly from the
Diagram Editor. Select LR Area Size from the Seftings meny:

XL L

A window with current LR area settings will appear. The LR area size, as wel|
as the remairing DR area size is displayed in the window.

,Fw,?& f.",}' 2 :-y '}3’ 5

s W

AL RNy G SN A -

The possibie selections for LR area size arc 0 bits, 64 bits, or 128 bils. The
selection will also affect the aumber of available DR words, as shown in the
window. At the bottom of the window are the LR area sizes currently found in
the PLC and Miniiss

To change the vaiue. move the selection bar o the desired line with the it

S
I Enter - .
and f¥ ] keys, and press E;‘g: The LR arca size will be changed m
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>
MiniL.SS. If MiniLSS is connected to a PLC a prompt wiill appear, asking for
confimation to change the values in the PLC as well.

To exit the LR Area definilion window press ffEsc).

The LR Area definition window can also be accessed from the Diagram Editor 5
by selecting LR Size from the PLC menu.

6.3.5. Setting Filter Values @

The input filter values can be set from the Muttimonitoring Page as well as
from the Diagram Editor. In the Diagram Editor select Fiters from the PLC
mend. In the Mullimonitoring Page select Filter Values from the Sellings &
menu.

Both selections witl produce a fitter definition window on the screen:

Ot X0 ~Cxrary (= a]
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To change the filter values, move the selection bar into desired group with
the and keys. The value can be changed with the and ;

keys, which scroll alf valid values. When the values of alf {he groups are set,

press to actually change the vaiues. [f the PLC is connected to
MiniLSS a confimation is asked for before updaiing the filter values in the
PLC.

6.3.6. Other PLC Commands

the PLC Commands menu on (he Multimonitoring Page contains commands
for setting the PLC mode, reading errors from the PLC, reselting the PLC and
backing up OR memory:
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The PLC made can be set to either Program mode or Run mode,
Emror read displays errors currently found in the PLC.
Resel the PLC command clears the the PLC memory,

Backup DR command transfers the data in DR area to EEPROM in the PLC.

6.4. Communication Errors

Monitoring requires continuous communication between the PC and the PLC
- the PC queries about states of the PLC's addresses and the PLC responds.
Occasionalty data received from the PLC wili have been altered during
transmission. The user will be informed of these communication errors when
detected, but no action is then required from him. The meassage will be
retransmitted and probably received the next time without errors.

58



rr

SECTION 7
7 SECTION 7
Compiling g
7.1. Compiling Diagrams ‘i

In the PLC the program is in executable binary format. Before a program of
diagrams and instruction lists can be downloaded o a PLC, it must be e
compited to that format. Using a programming device, the program appears :
in Mnemonic List formatl, or as a tist of instructions terminating in an END
instruction. in mnemoenic list format there is no division into instruction list
elements or diagrams. Diagram comments and address symbols are not
contained in the mnemonic list level. Minil.SS uses the mnemonic list format

as an infermediate level between diagrams and executable binary format.
Although you probabty never need to work with mnemonic list format, this file

is avaitable as <name>.MNE file on your disk.

The syntax of diagrams is checked during compilation. As the compilation is

a two-phase procedure, syntax checking takes place in both phases. Syntax :
errors will terminate the compiling. i
The following syntax checking is made: i

+ There are not any undefined symbols in the program.

« Every contact and output has a valid address. . i

Ladder diagrams are logically consistent.

Functions, counters and timers all have operands.

The following syntax checks do not terminate the program but prevent {‘
downloading: ' 23
-+ There is no END instruction at the end of the program. —

« The program does not exceed the maximum size of the selected PLC
type.

The following syntax checks do not prevent downloading:

+ The number of DIFU/DIFD instructions do not exceed the maximum [imit.
» ILALC check: for each ILC instruction there is at {east one IL instruction.
To begin compiling select Diagrams->OBJ from the Compile menu {or
Compile ->08J in FILE MNGT menu if in LSS mode). Open the program
befare compiling, as MiniLSS always compiles diagrams found in the

working space.

ff a syntax error is found during the first-phase compilation, the compilation
terminates and the syntax error is displayed:
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The syntax errors found in the secend-phase compilation will be displayed in
a window;

fE no syntax errors gre found, an execuiable object Gle s ¢reated The nameoe
of the file is the program's name and its extension 5 LQB. This file can he
downioaded o the PLC

There can be dragrams that connot be compibed o mnemonic {onmat using
only addresses assigned lo conlacts, bul g temporary savieng of inlermadiae
fesuits s required MimESS uses bis 0108 - 01 Phdor tHus pumpose 1o the
defaull symbol (able they aie named TempRelayl.8S. Do nol use (hese bits
duectly

I, for some resson you have o use any of addresses menboned, change
et symbol name This prevents Minil S5 W ouse thom Yoo should o Y
feave atjeast three temporaey bits for Moul S5 8 the canmplexaty of diagoame
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require more lemporary bits, you will get a compile ariar i s case assin
more temporary bits by setting the symbot text equal {o TempRelay( Ss.
Note that the symbol lext is case sensitive Alf temporary bits have 1o be in

word 01,
b
You can compile diagrams (0 8 mnemonic list and view the resulls on the
screen. Select Mnemo To Screen from the Compile menu. The first-phase W
compilation is execuied and the resulf is displayed on the screen: %
Wt tht oequ |
Ay v
p
grin

You can use this command to check the syntax of your diagrams without
having to compile {0 object code.

7.2, Compiling Object Code to Diagrams

An object file can alse be uploaded from the PLC and compiled lo diagrams,
When compiling, all logicaily consisten! portions are compiled to ladder
diagrams and the rest are put into instruction lists. Since the object file
containg no diagram comments, they wan't appear in the diagrams. If the
program s orginally created with Minil.SS. avou overwriting 1 by the
compilation of objec! code (o tiagrams.

7.3, Comparing Programs

Hoyou are uncertam about wheiher o peogram you created with MinilLl8S s
exaclly the same as the corresponding program in the PLC, ¢ g, f you have
made small changes with the programoung console without updating you
program [iles, you can verify the diffarences between (he pregrams in the
PLC and programs in Minil.8S First upload the program from the PLC: this
produces an object code Nile valh the extension LOB Load the diagiams
from disk and select Compare from (he Compife menu (or COMPARRE from

G
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e

the FILE MNGT menu if in LSS maede). /MiniLSS then prompts you to select
the object code file against which the diagrams should he compared. After
the file is selected, MinitLSs compiles the diagrams and the object code ig
maemonic ist and compares each mnemonic code line. if mismalches are
detected, the comparson stops and an error message is given with the
position where the mismatch was found. i the programs are idenlical, a
message is displayed,

If mismatch is detected, you can view the compiled mnemonic list from the
diagrams by selecting Mnemo To Screen from he Compife menu, and the
uploaded mnemonic list by holding the fAlt) key down and pressing §u'
Modify your diagrams and recompare.

Note that uploading and comparing programs is not needed if all
changes to your programs have been made with Minil.S 5.
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SECTION §
Customizing Display Colors

Dispiay colors (or altributes) can be customized. The need to change these
attribules may arise when using monocolor LCD or plasma displays which are
common in Laptop and Notebook PCs.

In each editor, pressing and leads to a display attribute

definition screen which appears as follows:

ROOL

=g <3 [- PG A

mach clon
lflr'* v

mlab T elulul -

The color selection displays can also be reached from the menus. In MiniLSS
mode select Colors from the Options menu, in LSS mode select Sareen
Colors from the Setup Menu.

The items and number of items depends on which editor you were in before
going into the display attribute definitions.

Select the item you want to aiter by pressing the numberfiefter which is

displayed to the fefl of the item. A window opens where all possible attribuies
are shown:

63

s
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The current color selection is displayed wilh brackets (J. You can change the
allribute seleclion by moving the brackets with cursor keys and accepling the

&

. - i =¥ ('
selaction with QN‘,

You can save allributes to disk and they will aulomati tically be loaded when
MiniLSS starls, or you can ioad the attributes from disk which will overnde
any allnbute changes that yvou have made since the last altribute save
operation.
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Cutting, 22; 24; 25; 39; 44
Diagram-Comments, 11; 17; 40; 44; 59
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Editing instruction list, 11; 14
Editor mode, 6; 9
Editor screen, 5; 6
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drawing, 7, 9
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special codes, 35; 36
Input Filters, 42; 46; 57
Justified Quiputs, 9; 11; 44; 50
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LR Area Size, 20; 42; 46; 56
Marking, 21; 22; 23; 24; 39; 44
Mnemonic List, 59; 61
Multimonitoring Page, 55
Multimonitoring Pages, 515 53; 54
Ounline help, 6
Orientation, 32
landscape, 32; 33; 34; 35
mixed, 32; 34, 35
portrail, 32; 33; 34, 35
Page fength, 35
Parallel port, 32; 42; 50
PL.C errors, 58
PLC mode, 58
PLC Number, 51
PLC type, 6; 20; 41; 50
Printers, 32; 42; 50
Printing, 39; 49
Searching, 41; 45; 46
Serial, 42
Serial port, 50
Shorteut keys, 7; 9

SI’IGSTD.S’fB, 15

Status Monitoring, 51

Symbol, 4063 47; 52

Symbel Table, 15; 16; 42; 44: 49; 51; 53

Symbols, 13; 14; 15; 16; 21; 29; 42; 55; 59; 61
undefined, 16; 20; 21; 59

Syntax rules, 8; 16; 59

TempRelayLSS, 61

Uploading, 61

Using monochrome dispiay, 5; 63
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